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XLNT Idea Xi440 and DiscStudio 
 

Your new Xi440 CD/DVD Printer with DiscStudio software is 
intended for small to medium-scale disc printing operations. The 
XLNT Idea Xi440 prints directly to inkjet-printable CDs or DVDs 
eliminating the need for stick-on labels with their attendant cost 
and inconvenience.  

This manual is intended to: 

• Familiarize you with the basic operation of your new Xi440 
CD/DVD Printer. 

• Provide detailed instructions for using the included XLNTIdea 
DiscStudio graphic design software. 

Features 

Your Xi440 has the following important features: 

• 4 colors for photo quality prints 
• Up to 4800 x 1200 DPI resolution 
• Simple one button tray load mechanism  
• High quality Lexmark engine 
• Disc prints cost less than labels 
• Print discs in as little as 18 seconds with 80% coverage 
• Interface for use with most autoloaders 
• Stylish modern Beige and Black case 
• Includes software for Windows 

Computer Requirements 

Your Xi440 is designed to work with Windows 2000, Server 2003, 
Windows XP and Vista. The supplied software does not work with 
earlier versions of Windows. Other minimum requirements are: 

• 128MB RAM 
• 300MB hard disc space 
• Pentium® or equivalent 300 MHz or greater 
• Windows 2000, 2003 Server, XP or Vista 
• 2x CD-ROM drive 
• Free USB Port 
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Unpacking Your XLNT Idea Xi440 

 

Your Xi440 is packed complete with these accessories: 

• Xi440 printer 
• 12 VDC plug in AC adapter 
• Black and Color ink cartridges 
• Software and driver CD 
• Xi440 Quick Start guide 
• This manual 

You will also need: 

• a USB printer cable (not included) 
• blank printable CDs or DVDs1 

To unpack the printer, open the top of the shipping carton and 
remove the accessories. Then place the box on its side and slide 
the Styrofoam shipping supports out of the box along with the 
printer. 

 

IMPORTANT:  The shipping carton and custom designed packaging 
should be saved to avoid damage to the Xi440 in case you ever 
need to transport or ship it. 

                                                           
1 The Xi440 can only print on CDs/DVDs designed for ink jet printing. Most 

media with a glossy surface is designed for use with stick-on labels and 
can't be printed in the Xi440. 
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XLNT Idea Xi440 Connections 
The rear panel of the Xi440 has four connectors as shown below: 

 

 

 

The connectors are as follows: 

Power Use only the original 30V DC adapter that comes 
with your printer. If the cord or adapter becomes 
damaged, replace it with an identical unit. 

Auto Loader Up to two different serial connectors (depending 
upon ordered configuration) are provided (a DB-9 
and/or a 6 pin DIN) for use with an external 
CD/DVD auto loader. The Xi440 is compatible 
with many different auto loaders. Go to 
www.xlntidea.com for further information and 
support software. 

USB Connector Use a USB printer cable to connect this port to 
your computer. The port is functional even if the 
printer is powered off so your computer will 
recognize the printer even while turned off. 
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XLNT Idea Xi440 Controls 
Your Xi440 has three operating controls for user input as shown 
below: 

PowerChange
CD

Change
Cartridge  

Power Turns printer power on or off. A green LED in the 
button illuminates when the printer is on. 

Change CD Pressing the Change CD button will extend the CD 
tray so you can insert or remove a CD. A red LED in 
this button will light either when the CD tray is 
extended or when the Change Cartridge button is 
pressed. 

 Press the button a second time to draw the tray and 
CD into position for printing. 

Change 
Cartridge 

Pressing the Change Cartridge button will move the 
cartridge holders into position so you can access 
them to change cartridges. The red LED in the 
Change CD button will light when this button is 
pressed. 

 Press the button a second time to move the cartridge 
holders back to default position and restore normal 
operation after cartridges are changed. See page 13 
for details. 
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XLNT Idea Xi440 – Set Up 

 

To properly and quickly install your Xi440 and DiscStudio software, 
please follow the included Quickstart Guide. The following sections 
of this manual give the same information as the Quick Start Guide 
with more detailed information. 

Step 1 – Plug In 

 

Locate the AC adapter and plug the AC power plug into the nearest 
AC wall outlet. Plug the small male connector into the female 
connector on the back of the Xi440 CD/DVD Printer.  
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Step 2 – Power On 

 

If it does not automatically turn on when the power adapter is 
plugged in, press and hold the Power button until the light inside 
the button turns on. 
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Step 3 – Installing the Ink cartridges 

 

With the printer powered on, raise the center lid of the printer and 
press the Change Cartridge button to slide the ink cartridge holders 
into exchange position. 
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Step 3 – Installing the Ink cartridges - continued 

 
Remove the ink cartridges from their foil packages and remove the 
tape covering the print heads taking care not to touch the print 
heads or the gold contacts on the back. 
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Step 3 – Installing the Ink cartridges - continued 

 

Press the tabs on the front of the cartridge holders inward. 

 
1. Press the tabs inward 
2. Lift the covers upward to open. 
3. Place the ink cartridges into their holders taking note to use 

the correct color coded holder (light green cartridges go 
into the light green holder and dark green cartridges go into 
the dark green holder). 

4. Close the covers until they latch onto the lower holders as 
before. 

 
 

 

1 2

 

 

4 3

 

 

 

Note: You should never have to force the ink cartridges into their 
holders, if excessive force is necessary, remove and reinsert the 
cartridges or check for any obstructions within the holders. 
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Step 4 – Connect the Xi440 

 

With the XLNT Idea Xi440 CD/DVD Printer and your computer 
turned on, plug the male rectangular end of the USB cable into an 
available female USB port on the back of your computer; plug the 
male square end of the cable into the female USB port on your 
printer. 
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Step 5 – Install Software 

 

Open the CD-ROM drive on your computer and place the XLNTIdea 
Setup CD into the DVD drive and close the drive. 
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Step 5 – Install Software - continued 

 

If autorun is enabled on your computer the following screen will 
appear.  If autorun is not enabled navigate to the drive you placed 
the XLNTIdea Setup CD and double click on the “setup.exe” 
application contained on the disc and the following window will 
appear. 

 

Leave this window open but DO NOT click the “NEXT” button at 
this time. 
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Step 5 – Install Software - continued 

 
When the Xi440 printer is powered up and connected to your 
computer, Windows will automatically detect the Xi440 the first 
time the printer is connected. The New Hardware window shown 
below will appear: 

 

Select "No, not this time" and click the “Next” button, the 
following window will then appear. 

 

Check the "Install from a list or specific location" box and click 
“Next” button. 
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Step 5 – Install Software - continued 

 

This will then open the following window. Check the "Search 
removable media" box and click “Next”. 

 

Once your computer locates and begins copying the drivers from 
the XLNTIdea Setup CD the window shown below will appear. In 
spite of Windows warning, this software will not impair or 
destabilize your computer! Click on the "Continue Anyway” 
button. 
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Step 5 – Install Software – continued 

 

After the Xi440 driver installation has completed the final window 
will appear. Click the “Finish” button. The required drivers for your 
Xi440 have now been installed.  

 

 

 

 

Cartridge Alignment can now be setup by continuing to Step 6. 

 

 

 

22 



Step 6 – Cartridge Alignment 

 

The ink jet cartridges must be aligned EVERY time new cartridges 
are installed. 

To align the ink cartridges go to “Start Menu > Settings > 
Printers and Faxes” find the Xi440 printer icon in the list and 
Right Click on it. From the pop up menu select “Properties” and 
then select the “Cartridge Maintenance” tab in the XLNTIdea 
Xi440 CD/DVD printer Properties window. Then Click the 
“Install/Change Cartridge” button from the window (shown 
below) that opens. 
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Step 6 – Cartridge Alignment (continued) 

 

From the pull down menus of the window that opens (Shown 
below) select the type of cartridge you have installed. (The 
XLNTIdea Xi440 is shipped with 10N0027 and 10N0017 
cartridges). Then click the “Continue” button. 
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Step 6 – Cartridge Alignment (continued) 

 

On the next screen that appears click the Continue button again. 

 

After a few moments the XLNTIdea Xi440 will extend its Disc Print 
Tray and the Center Control Button will turn RED, Place a blank 
inkjet printable CD/DVD into the tray and press the center Change 
CD Button on your Xi440. This will draw the tray back into the 
printer and begin the “Cartridge Alignment Test”. 
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Step 6 – Cartridge Alignment (continued) 

 

When the disc has finished printing, remove the disc from the tray 
and note the arrows that were printed onto your disc, Use your best 
judgment to pick the arrow that stands out most from the 
surrounding lines. Taking note of the letter (A,B,C or D) next to 
each row of arrows. 

 

Enter the number of the arrow judged best into the corresponding 
letter box in the window (Shown below) that opens. When you are 
finished click the “OK” button to close the window. 

 

Congratulations you have successfully setup your XLNTIdea Xi440 
CD/DVD Printer for optimum printing. 
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Setting Printing Characteristics 
 

The XLNTIdea Xi440 can be set for different print quality and 
densities. Choosing the best values can make a significant 
difference in the quality of your printed discs. 

Quality settings are made from the Xi440 Properties panel. Go to 
Start Menu > Settings > Printers and Faxes, then right click 
the Xi440 printer icon and select "Properties". 

1. From the Xi440 CD/DVD printer Properties window that opens 
Click on the General tab. 

2. Click Printing Preferences button from that tab to open the 
Printing Preferences window.2 

3. Click on the Paper/Quality tab to change your printing 
preferences. 

Don't change any settings under the Layout tab. Settings 
under this tab don't apply to the Xi440. 

 

                                                           
2 The Printing Defaults window is also available under the Advanced tab 

(Printing Defaults). 
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Setting Printing Characteristics (continued) 

 

Paper Source Leave this setting at “Automatically Select” 

Media The Media settings affect the amount of ink used 
per pixel. Settings will effect the color saturation 
of the image, but will use more ink. Use the 
lowest setting that gives the results you want in 
order to conserve ink. 

• Standard (lowest saturation and ink use, 
quicker prints) 

• Coated (medium saturation and ink use – 
default setting for your Xi440) 

• Glossy (highest saturation and ink use, longer 
print time) 

 

 

 

Quality Settings These quality settings affect the print resolution 
in DPI (dots per inch). Higher resolution means a 
clearer image but takes longer to print. Available 
settings are: 

• Best (4800 x 2400 DPI) 
• Normal (600 x 600 DPI, default setting) 
• Draft (300 x 300 DPI) 
• Custom (set by clicking the Advanced button) 

Color You may choose to print in Black and White or 
Color. If your label is in black and white or grays 
only, you can choose Black and White. This will 
disable the color cartridge in the printer and print 
from only the Back cartridge. 
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Setting Printing Characteristics (continued) 

 

Click the Advanced button from the Paper/Quality window (see 
page 29). 

 

 

 

A number of printer features may be adjusted from this window see 
descriptions on next page. 
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Setting Printing Characteristics (continued) 

Paper Size This allows you to select CD size. Unless you have 
the printer adapters which allow the use of smaller 
CDs, leave the setting at CD/DVD fullsize.3

 

Copy Count Leave this set to 1. You may adjust the number of 
copies at print time. 

Print Quality This sets the printer resolution. It is the same as 
using the Quality settings in the Paper/Quality 
window except that a 1200 x 1200 DPI option is 
available here. Click on the numbers to open the 
pull down list, and then select the desired setting. 

 

 

 Note: This list is only available if you have checked 
Custom in the Paper/Quality window's Quality 
setting. 

Document 
Options 

Leave Advanced Printing Features at the default 
"Enabled" setting. 

Color Intent For photographic and continuous tone images select 
Normal. For line drawings and most graphic images 
select Graphic. The Graphic mode will produce 
greater saturation and more vibrant colors. 

 

 

Bidirectional 
Support 

This must be left ON. 

                                                           
3 The Paper Size setting is also available from the Device settings tab in the 

main printer Properties window where it is called Upper Paper Tray. 

30 



Installing DiscStudio 
 

Place the XLNTIdea Setup CD into the DVD-ROM drive of your 
computer  

• If the program doesn't start, double click on My Computer and 
navigate to the CD drive (on most computers this will be D:\. 
Double click the file named "setup" or "setup.exe". 

The software setup window (below) will display: 

 

Click “Next” to continue with software installation. During this 
process you may either install to the default folder or choose 
another location. We recommend using the default folder. 

Click the “Finish” button once the installation is done. 

The installation will also create a program shortcut in Start Menu. 

31 



DiscStudio – Setup and Use 
 

The DiscStudio software included with your printer is a full featured 
software solution for the design and printing of full color labels 
directly onto ink-jet Printable CD/DVD discs. 

Calibrate Print Position 

The first time you run DiscStudio a Print Setup window will prompt 
you to select a printer.  Please select Xi440 CD/DVD Printer from 
the drop down menu and click OK. 

DiscStudio must be aligned to your printer before you can print CDs 
or DVDs accurately.  This procedure need only be done once unless 
you change printers.  Alignment is remembered from session to 
session and saved when you quit the program. 

 

Open DiscStudio then from the File menu select Printer 
Alignment. 
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Step 16 – Calibrate Print Position (continued) 

 

The following window will appear: 

 

This window provides adjustment for the X and Y positions of the 
printed image.  Do not set them manually at this point.  Click the 
Print Alignment Image button in the lower left corner and the 
Xi440 will extend the print tray. Place a disc to print into the print 
tray and press the center Change CD button. 

The Xi440 will then begin to print.  
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Step 16 – Calibrate Print Position (continued) 

 

When the disc has finished printing and the tray has fully extended 
remove the disc from the tray and examine it. 

The printed disc will look like the following image: 
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Step 16 – Calibrate Print Position (continued) 

 

Now place this disc back into the Print Tray with the arrow on the 
printed disc pointing directly towards the front of the Xi440. 

Close the Xi440 cover and click the “OK” button in the onscreen 
window. 

 

 

This will print a second image of 2 black alignment arrows on the 
previously printed disc. After the Xi440 has finished and the print 
tray has fully extended, remove the printed disc.  
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Step 16 – Calibrate Print Position (continued) 

 

X Axis alignment 

Examine the printed CD carefully looking first at the area marked X 
Axis. 

 

Note that (in this example) the tip of the arrow points to the right 
edge of the blue line under the letter G. 
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Step 16 – Calibrate Print Position (continued) 

 

To adjust X Axis alignment, use the 
Right and Left arrows to scroll 
through the letters and colors to 
match as closely as possible those on 
the printed disc. 

 

Note: The values for your printer will 
almost certainly differ from those 
shown here, which are examples for 
illustration only. 
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Step 16 – Calibrate Print Position (continued) 

 

Y Axis alignment 

Now examine the area of the CD marked Y Axis. 
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Step 16 – Calibrate Print Position (continued) 

 

The tip of the black arrow is at the beginning of the green band 
under the letter G. 

 

To adjust the Y Axis alignment, use 
the Up and Down arrows to scroll 
through the letters and colors to 
match as closely as possible those on 
the printed disc. 

Note: The values for your printer will 
almost certainly differ from those 
shown here, which are examples for 
illustration only. 

Both X and Y values will be 
remembered from session to session 
and need only be set once for each 
Xi440 printer that you use. 

 

0 for 
optimum printing.  You may now continue with DiscStudio. 

 

Congratulations! You have successfully setup your Xi44
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Navigation 

 

The DiscStudio window is divided into several main sections, as 
shown in the illustration below. 

 

Drawing 
Tools 

These tools allow you to draw and manipulate 
objects of various shapes.  You can set line colors, 
fill colors and gradients, move objects in front of 
or behind others, and select a grid to make 
alignment easier. 

Select 
Template 

Default templates are provided for various sizes of 
discs and may be further adjusted to fit your 
needs. 

Background 
Settings 

Allows you to import and adjust bitmap graphic 
files to use as backgrounds. 

Drawing 
Area 

This is where you manipulate elements of your 
design and preview your label to be printed. 
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Included Fonts, Backgrounds and Clipart 

 

A DiscStudio installation includes a large selection of images and 
fonts you can use for your labels. 

 

Fonts 

A large selection of True Type fonts is included with DiscStudio. 
These fonts extend the selection you already have installed within 
the Windows operating system. By default you'll find these fonts in: 

C:\Program Files\XLNTIdea\DiscWorks\Fonts 

 

The fonts are not installed within Windows which means they 
cannot be used in other applications. This avoids slow Windows 
performance that may occur when large numbers of fonts are 
installed within the Windows operating system.4 

 

Backgrounds and Clipart 

DiscStudio includes a large selection of background and clipart 
images. By default these are stored in the following folders: 

 

C:\Program Files\XLNTIdea\DiscWorks\Backgrounds 

C:\Program Files\XLNTIdea\DiscWorks\Clipart 

 

For further information about backgrounds and clipart see page 76. 

                                                           
2 You can use the normal Control Panel Fonts utility to install any of the 

supplied fonts if you need them for other applications. 
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Opening and Saving Files 

Starting a New File 

When you start DiscStudio, it's all set for you to start creating a 
label. So you don't actually need to use the New button to create a 
new file. However, if you are done with one label and want to work 
on another, save the first label, then select File > New to clear your 
workspace completely. 

 

To open or save files, or start working on a new 
label, click on the File option in the upper left of 
the DiscStudio window. 

Labels are opened from and saved as single 
composite files, which embeds all backgrounds, 
artwork and text.  These files can be copied to 
another computer which has DiscStudio installed.  
To do this, when ready to save a label, choose 
Save As Image.  To simply save the label, without 
the need of copying the label to another computer, 
click on Save As, and choose a file name. 

 

 

Saving a File 

Once you have prepared your CD/DVD label, save it by selecting 
File > Save. This will open a standard Windows file dialog where 
you can choose the filename and location.  

By default, DiscStudio will save files in the My Documents folder. If 
you want to change this choose any folder you want using the file 
dialog window. 
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Opening and Saving Files (continued) 

 

Opening a File 

Select File > Open to open an existing label file, and if you have a 
label open that has not been saved prompt you to save it.  

 

Note: DiscStudio label files have the extension .dst. 

 

The default folder for DiscStudio is the My Documents folder unless 
you have changed this when saving a file previously.  You can open 
DiscStudio files from any accessible folder; as the Windows file 
dialog window allows easy browsing to find the correct file you 
need. 

 

Other Options 

As described earlier, Printer Alignment can be performed from this 
menu.  In addition, the Printer Setup and Print choices are located 
here.  It is a very good idea to check your setting in File > Printer 
Setup, prior to printing, as changing these options will greatly 
affect the quality of your print, and the amount of time required to 
print each label. 
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Selecting a Template 

To select a template, click the Select Template button (top right of 
the Disc Studio screen) and choose a suitable template from the 
list.  If you are going to print to your Xi440, the Xi440 CD/DVD 
Printer should be selected by default.  The Disc Studio software also 
includes many popular templates so if you are going to print to 
another printer (i.e., a desk jet, or laser printer) you may choose 
from the available templates that matches the label template that 
you will be printing on (see image): 
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CD/DVD Disc Settings 

 

When printing to your Xi440, you may choose the type of CD/DVD 
that you are printing on from the drop down list, by clicking on the 
down arrow to the right. If this option is not shown the Xi440 
CD/DVD AutoPrinter has not been selected from your templates as 
previously shown.  
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CD/DVD Disc Settings (continued) 

 

You may also adjust the template to suit your requirements using 
the sliders or input windows in the Templates section, shown 
below: 

 

 

 

All dimensions are in inches by default.  To change to metric simple 
select the Edit menu and click the Metric option. Click Standard to 
change back to inches.   

Each setting can be set either by moving the sliders or typing 
values into the text boxes.  The changes appear immediately in the 
Drawing Area of the window. 

Inner Diameter sets the diameter of the blank area at the center of 
the CD/DVD.  

Outer Diameter sets the outer diameter of the printable area. 

Business Diameter sets the cutoff at top and bottom of the 

CD/DVD, as used for "business card" CDs or DVDs. 

Note: Be careful in the adjustments as printing too far into the 
inner diameter or too far to the outside diameter of some discs 
may result in excess ink that is not absorbed by the disc 
resulting in ruined discs or damage to the Xi440. 
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Using the Drawing Tools 

 

The drawing tools are available from the 
Drawing Tools section of the interface 
(shown at the right). To use a tool, click 
one of the buttons and then click in the 
drawing area to build your object. 

To help you align objects accurately, a 
grid is available by clicking the grid 
button below the drawing tools: 

 

Once objects are aligned you can remove 
the grid by clicking the grid button a 
second time although the grid is only for 
reference and will never be printed. 

 

 

 

Drawing tools include (from top left): 

 

Selection Tool Text 

Freehand Clipart 

Open Curve Closed Curve 

Rectangle Polygon 

Rounded 
Rectangle 

Ellipse 

Halo Arc 

Arrow Line 

 

The drawing tools are described in detail starting on page 49. 
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General Notes 

 

To draw any object, click the button for the object you wish to 
create then click within the drawing area. When you are done, 
finish the object either by double clicking on the last handle (see 
image, below) or by releasing the mouse button and clicking once 
in the same position (differences are described for each tool in the 
sections below). 

 

 

 

Once an object has been created, it can easily be resized, moved, 
reshaped and its line and/or fill properties can be modified. 

 

Correcting Errors 

DiscStudio has multi-level Undo (Ctrl+Z) and Redo (Ctrl+Y) 
functions, located under the Edit menu.  Simply select UNDO to 
undo the last action.  Selecting UNDO repeatedly steps back 
through your previous steps.  If you step back too far, or change 
your mind, click REDO to step forward again. 
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General Notes (continued) 

 

Selecting and Adjusting Objects 

To select a closed object (rectangle, circle, etc.) left click anywhere 
within the object.  When selected, small black, square handles will 
appear.  Click and drag a handle to reshape or resize that object. 

To select a line object (curved or straight), left-click anywhere on 
the line.  Handles will appear to let you resize or reshape that 
object. 

You can select multiple objects by clicking and dragging a selection 
rectangle just as you would select multiple icons on the Windows 
desktop (make sure the cursor pointer is a normal "arrow" before 
doing this). 

You can move most objects by clicking anywhere within a closed 
object (or on the line for a line object) and dragging with your 
mouse.  Do not click on a handle or the object will be reshaped 
instead of being moved. 

To unselect an object, click anywhere outside the object, or click 
the Selection Tool, on the left-top of the screen. 

 

Clearing a Drawing Tool Selection 

If you have selected a drawing tool and then change your mind, 
right click outside the drawing area (the grey area), to clear the 
selection and return to the Selection Tool, on the left-top of the 
screen. 
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Description of the Drawing Tools 

 

Note:  The following sections refer frequently to Line and Fill 
properties.  For detailed information, see page 66. 

Open Curve Tool 

Function Draws a curved line. 

Position Any 

Features Line properties  
 

 

The Open Curve tool lets you draw curved lines. Click this button 
then click and release to set the starting point in the drawing area. 
Move the mouse to the set the next fixed point on the curve, and 
click to establish the next fixed point.  Continue to make as many 
fixed points as required. 

Double-click to close the Open Curve Tool.  When the object is 
selected, drag any of the fixed points to change the size or shape of 
the curve. 
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Description of the Drawing Tools (continued) 

Closed Curve Tool 

Function 
Draws a curved line with the ends 
connected to make a solid object. 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

The Closed Curve tool lets you draw shapes with curved sides. 
Unlike the Open Curve tool these shapes are closed and can be 
filled.  Select the tool button, then click and release to set the 
starting point in the drawing area.  Move the mouse to the next 
fixed point on the curve and click to establish the fixed point.  You 
will see that the latest fixed point is connected to the starting point. 

The object will remain selected.  After you have made your last 
desired point, double-click to close the object.  While the object is 
selected, drag any of the fixed points (handles) to change the size 
or shape of the curve. 

 

Example and Hints 

As an example, we'll draw a shape resembling a guitar pick. 

 

We start by clicking at point 1, move to point 2 and click again, 
then move to point 3 and click to complete the object as shown at 
the left, then, double-click to close the object.  Then, click outside 
the object to unselect it, so we can take a look.  The finished object 
is shown on the right.  If it's not symmetrical, click a handle and 
adjust it as required. 

51 



Description of the Drawing Tools (continued) 

Freehand 

Function 
Draws a freehand shape made of straight line 
segments  

Position Any  

Features 
Line properties (for closed shapes use Polygon 
Tool) 

 

 

The Freehand tool lets you draw an object made of line segments.  
Unlike the Polygon tool (see below) the object is a line, and even if 
you attempt to close it by putting the end point on the starting 
point, it remains a line and can not be filled. 

Simply click where you want the freehand shape to start, release, 
move to the next point, click again, and so on.  Double-click to 
create the final point and close the Freehand tool. 
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Description of the Drawing Tools (continued) 

Polygon 

Function 
Draws a closed freehand shape made of 
straight line segments.  

Position Any  

Features Line and fill properties, background, clipart  

 

The Polygon tool works much like the Freehand tool, but it creates 
closed shapes that can be filled.  As you create fixed points you'll 
see that the last one is always connected back to the starting point. 

Simply click where you want the polygon to start, release, move to 
the next point, click again, and so on.  Double-click to close the 
Polygon tool. 
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Description of the Drawing Tools (continued) 

Rectangle 

Function Draws a rectangle (including squares). 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

The Rectangle tool draws a rectangle starting from the first point 
you click. Click the Rectangle tool, click where you want the first 
corner to be, then hold and drag to set the size and shape.  When 
you're done, release and click to create the final point and close the 
Rectangle tool. 

To make perfect squares use the Grid to align the sides to the lines 
in the grid.  You can adjust your rectangle by re-selecting it and 
dragging a handle. 
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Description of the Drawing Tools (continued) 

Rounded Rectangle 

Function Draws a rectangle with rounded corners. 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

The Rounded Rectangle tool behaves much like the Rectangle tool, 
but lets you have rounded corners.  Click where you want the first 
corner to be, then hold and drag to set the size and shape.  Release 
and click to set the final point and close the Rounded Rectangle 
tool.  Now the Rounded Rectangle will look like an ellipse. 

 

Created within the rounded rectangle is a shape handle which looks 
like the points on a compass, this can be dragged horizontally or 
vertically to shape the corners of the object.  A little 
experimentation will show you how this works.  Of course, the size 
and aspect ratio can be adjusted by dragging any of the other 
handles. 

 

55 



Description of the Drawing Tools (continued) 

Ellipse 

Function Draws an ellipse (including circles) 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

The Ellipse tool lets you draw ellipses and circles.  Click where you 
want one "corner" of the ellipse frame, and drag to create the size 
and shape you want.  Release and click to set the final point and 
close the Ellipse tool.  Use the Grid to adjust the ellipse accurately, 
for example if you want to create a circle. 

 

Note:  By default the Ellipse tool will always draw a perfect circle, 
to change this select the object and uncheck the Lock Aspect Ratio 
box under the Shape box on the Upper Right hand side of the 
window. 
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Description of the Drawing Tools (continued) 

Halo 

Function 
Draws an elliptical "ring" or halo 
(including circular). 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

The Halo tool draws a 360° solid elliptical arc such as the one 
shown at the left, below: 

 

 

 

When selected, the shape of the inner ellipse can be changed by 
moving the Inner Shape handle in two dimensions.  The shape of 
the outer ellipse can be adjusted using the outer handles. 

Click the Halo tool then click in the drawing area.  This will create 
the starting point of the rectangle that contains the halo.  Drag to 
generate the halo with the approximate size and shape you want. 
Release and click to set the shape and close the Halo tool. 

Note:  By default the Halo tool will always draw a perfect circle, to 
change this select the object and uncheck the Lock Aspect Ratio 
box under the Shape box on the Upper Right hand side of the 
window. 
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Description of the Drawing Tools (continued) 

Arc 

Function 
Draws an elliptical arc (including circular 
arcs) 

Position Any 

Features 
Line and fill properties, background, 
clipart 

 

 

An elliptical arc looks like this: 

It is a solid object that can be 
filled.  The position and shape 
can be adjusted in a variety of 
ways.  

 

Click the Arc tool then click in the drawing area.  This will create 
the starting point of the rectangle that contains the arc.  Drag to 
generate the arc with the approximate size you want.  Release and 
click to set the final shape and close the Elliptical Arc tool.  

To adjust the arc, click anywhere within the arc itself.  The arc will 
be selected and handles will appear. Note the drawn arc is the 
darker line while the circle is used only as a reference to the limits 
of the arc. 

 

Click and drag the Angle handle to increase or decrease the angular 
size of the arc.  Click and drag the Rotation handle to rotate the arc 
around its midpoint.  Click anywhere within the rectangle (but not 
on a handle) and drag to move the arc anywhere on the drawing 
area. 
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Description of the Drawing Tools (continued) 

 

Arc (continued) 

The Inner Shape handle moves in two dimensions to control the 
shape of the inner ellipse only.  Use any of the outer handles to 
control the shape of the outer ellipse.  Use the grid to help adjust 
the arc to be circular, if required.  When you're done, click 
anywhere outside the rectangle to un-select the object. 

 

Important: Don't drag the Angle handle to either 0° or 360°.  If you 
do, the arc will vanish and you'll have to start over again.  If you 
need a full 360° use the Halo tool instead. 

 

Note:  By default the Arc tool will always draw within perfect circle, 
to change this select the object and uncheck the Lock Aspect Ratio 
box under the Shape box on the Upper Right hand side of the 
window. 
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Description of the Drawing Tools (continued) 

Line 

Function Draws a straight line. 

Position Any 

Features Line properties 
 

 

The Line tool draws a straight line at any angle between any two 
points. Click the tool, click and hold to set the starting point, drag 
the line to set the angle and length, then release and click again to 
set the end point.   

In addition, changes can be made to the line, from the options on 
the right of the screen, such as border and arrow styles.  
Experimentation will quickly show you how it works. 
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Description of the Drawing Tools (continued) 

Clipart 

Function 
Draws an elliptical "ring" or halo (including 
circular). 

Position Any 

Features Line and fill properties, background, clipart 
 

 

The Clipart Tool, allows you to insert an image onto your label.  It 
can be from the clipart library, or an image of your own.  Simply 
click on the Clipart Tool, then click anywhere in the drawing area.  
A dialogue box will appear, giving you the ability to locate, and 
select the image that you want to add.  Simply locate the image, 
then double-click it, or click on Open. 

 

 

 

After an image from the clipart library has been opened in the 
drawing area it can be easily resized by click and dragging the 
handles surrounding that image as shown below. 
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Description of the Drawing Tools (continued) 

Arrow 

Function Draws a straight arrow in any direction 

Position Any 
 

Features Line properties, arrow properties 

 

The Arrow tool works just like the Line tool but generates heads 
and tails for the arrows.  Click the tool, click the point where you 
want the arrow point to begin, then hold and drag the mouse to 
draw the arrow.  Release and click to set the final position and close 
the Arrow tool.  You can adjust the position later if required. 

In addition, changes can be made to the arrow, from the options on 
the right of the screen, such as border and arrow styles.  
Experimentation will quickly show you how it works. 
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Description of the Drawing Tools (continued) 

Text 

Function Places straight or curved text on the label. 

Position Any 

Features 
 

Text properties 

 

The Text tool lets you place text anywhere on the drawing area. 
The font, size, color, edge and shadow properties can be set using 
the text properties, either before or after the text is created. 

Text will be generated inside a text box.  To create a text box, click 
on the Text Tool.  Then, click anywhere in the drawing area.  The 

cally appear in 
e drawing area.  When finished typing, click anywhere in the 

rawing area.  To edit the text and / or its properties, simply click 
on the text box that you just created, and the text window, and its 
properties will appear to the right.  Any changes that you make 
therein will be applied immediately. 

You can resize the text box. Text will automatically word wrap as 
necessary to fit the box. 

Also notice the Format, Font and Effects tabs that appear when you 
are using the Text tool these allow almost infinite variations to the 
text on screen by offering changes in shape, size, a multitude of 

ecial effects as well as hundreds of included fonts to fit any 
gn you can imagine. Examples of these features can be found 

beginning on page 82. 

word “Text” will appear.  Now, click in the window on the right, 
where word “Text” is also located.  Delete the word, and type the 
text that you want in your text box.  It will automati
th
d

sp
desi
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Manipulating Objects 

 

The attrib
and then uti

ut  es of objects can be changed by selecting the object
lizing the options on the right (see image): 
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Manipulating Objects (continued) 

 

Shape:  Any selected shape (other than line or arrow), may be 
changed to another shape, by selecting another shape from the 
dropdown box (see image): 

 

 

 

Keep Symmetric:  When checked, if the shape is resized, it will be 
centered, and will also be sized symmetrically. 

 

Transparency:  The transparency of an object may be changed by 
either manually entering a number into the box, using the up and 
down buttons or by using the slider (see image): 
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Manipulating Objects (continued) 

 

Border:  The border of objects may be changed here (Color, Size, 
Dash style, and Cap style).  See image: 

 

 

tion (see image): 

 

Arrow:  The properties of an arrow (Begin Style & Size, End Style 
& Size), may be changed from the following sec

 

 

 

Defaults:  The defaults button (lower right of window) can be very 
useful.  If an image is selected, and custom colors / settings have 
been applied, and you click the Default button, its settings will 
revert back to DiscStudio’s default settings, and be applied to that 
image.  In addition, if no image is selected and the button is 
pressed, any custom settings on the right of the screen (Color, 
Border, etc.) will be reset to DiscStudio’s default settings. 
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Line and Fill Properties 

 

DiscStudio lets you set a number of parameters that control both 
lines and fills (the color, background, patterns and images that fill 
areas of solid figures).  You can set these properties before or after 
n object is created, and you can set properties that apply to all 

subsequently created objects until they are changed. 

Note:  If you select multiple objects by dragging a selection 
rectangle around them, you can then apply properties to all of the 
objects simultaneously by using the techniques described below. 

 

Warning! Use caution:  if you change the shape, for example, 
all of the selected objects will be changed to the new shape. 

 

a
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Line and Fill Properties (continued) 

atterns and Gradients 

rosshatching, 

P

In addition to solid and transparent colors, objects can be filled with 
an image, gradients, and patterns.  An image is a graphic file on 
your computer (such as the included clipart or your own image).  A 
gradient is a combination of colors where one color gradually shifts 
to another color.  A pattern is a bitmap such as c
diagonal lines, etc.  To apply any of these to an object, simply 
right-click on the object to see the following image: 
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Line and Fill Properties (continued) 

Fill Image 

Select this to fill the selected object with an image (such as the 
included clipart or your own image): 
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Line and Fill Properties (continued) 

Fill Pattern 

e pattern, and the colors for 
e pattern: 

 

Select this to apply a pattern to an object.  The following window 
will appear where you can choose th
th
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Line and Fill Properties (continued) 

Fill Gradient 

tyle: 

Select this to apply a gradient fill to an object.  The following 
window will appear where you can choose the colors, transparency, 
and shading s
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Duplicating Objects 

eated.  For example, you could have the same 
bject in different places on your label, but having different colors 
 each place.  Click on Edit, in the upper left of the window (see 

image): 

 

 

Objects can be duplicated and used as often as required.  Each 
duplicate is actually a new object, so its properties can be adjusted 
after it has been cr
o
in

 

 

To duplicate an object, select the object, then click on Edit, and 
choose Copy.  Then, click on Edit again, and choose Paste.  Another 
way to duplicate an object is to simply select the object, click on 
Edit, and click on Clone.  A duplicate of that object will appear in 
the drawing area. 
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Using Levels 

 

DiscStudio provides extensive level support.  This allows objects to 
be moved in front of or behind other objects.  Used in conjunction 
with transparency, a useful range of effects may be obtained.  Click 
on Arrange in the upper left of the main window (see image): 

 

 

 

To utilize these functions, simply select an object, and then 
choose one of the above options to change its order on the 
page.  Objects in the Print Area are “layered” in that, they 
can overlap (or even cover) one another. 

 

You can't move an object behind the label background. 
Backgrounds form the base level for the label. 

 

e: Exampl

The simplest way to explain the operation of the level controls is to 
use an example.  We will start by drawing two shapes, an ellipse 
and a rectangle. 

 

The ellipse is filled with light grey and the rectangle is filled with 
white. 
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Using Levels (continued) 

ext, we will select the ellipse and slide it so that it overlaps the 
e. 

N
rectangl

 

 

 

The ellipse appears to slide behind the rectangle because its level is 
behind the level of the rectangle. 

 

ote: Objects are created in the foreground, so more recent 

rectangle, select the 
llipse, and then click on Arrange, and then Move Forward (you 
ay need to do this more than once depending on how far "back" 

N
objects will appear to be in front of older ones. 

 

If we want the ellipse to be in front of the 
e
m
the ellipse is). 

 

Since there are multiple levels, you can have several objects 
overlapping and decide in which order they are to be stacked.  

 

 

In the above example, the arc is progressively moved from back to 
front, one level at a time. 
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Transparency and Levels 

 

Transparen
th

cy can be used with levels to allow objects to "show 
rough" other objects.  In the left image below, the ellipse is 

behind an opaque rectangle (the rectangle's transparency is zero). 

 

 

 

In the right image, the rectangle's transparency has been set to 
50%.  Now you can see the ellipse through the partly transparent 
rectangle. 

 

Note: Set transparency using Fill properties as shown on page 109. 
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Zoom 

 

You can zoom in and out to make working with small objects easier 
using the three Zoom buttons: 

 

 

Zoom in makes the image larger 

Zoom out makes the image smaller 

 

 

Zoom full size returns to the full sized 
bel la

 

When you click a zoom tool, the mouse pointer changes to a 
magnifying glass with a + (zoom in) or – (zoom out). Click 
nywhere on the drawing area to zoom.  Once selected, the Zoom 

smaller without re-selecting the tool each time.  The Zoom tool 
button is unselected if you choose any drawing tool. 

 

To unselect a zoom tool without selecting 
a drawing tool, just click on the Pointer 
selection 

a
in and Zoom out tools remain selected so you can zoom larger or 
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Using Backgrounds and Clipart 

 of the DiscStudio program folder, 
nd are shown as thumbnails when you use the Select Background 
r Select Clip Art buttons.  

ther the entire CD/DVD or to any 
selected object.  Clipart (usually smaller images) is designed to  

 objects. 

 

ackground images and patterns are always behind all objects 

 

DiscStudio includes a large selection of backgrounds and clipart. 
These are stored in subfolders
a
o

Backgrounds can be applied to ei
 be

used for adding images as individual

Applying a Background 

 

B
you've drawn. You can't move an object behind the background. 

 

To apply a background to the entire CD/DVD use the tools in the 
Backgrounds section of the main interface, on the far right: 

 

 

 

Here you can choose a background image, a hatched pattern, a 
solid color, and make adjustments to the background you've 
selected. 
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Using Backgrounds and Clipart (continued) 

 

 

Adjusting the Background Image 

Once a background has been applied, click Adjust Background to 
open the adjustment overlay.

 

 

 

Use the arrows (or type in + or – X and Y values) to move the left, 
right, top or bottom margins of the background image, and the 
Background Scale slider, to adjust the size of the image within the 
design area. 

hen you're done, click Finish to close the overlay. W
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Using Backgrounds and Clipart (continued) 

 

Adding Your Own Backgrounds or Clipart 

any other source can be used by 
scStudio as backgrounds or clipart. 

 

Usable Image Types 

 

You can add images with any of the following formats: 

Type Extension Notes 

Bitmap images created by other graphics programs, imported from 
digital cameras, scanners or 
Di

JPEG .jpg, .jpeg Compressed bitmap graphics, used 
primarily for photos. Not recommended 
for line drawings, cartoons, etc. This is 
the default for backgrounds. 

Windows 
Bitmap 

.bmp Windows standard uncompressed 
bitmap format. 

GIF .gif Compressed bitmap graphics, 256 color 
maximum. Allows transparency. Good 
for line drawings, cartoons, etc. This is 
the default for clipart. 

TIF .tif, .tiff May be compressed us g LZW lossless 
compression. Cross platform. 

in

Windows 
Metafile 

.wmf Used by Windows clipboard. Metafiles 
may be vector or bitmap. 

PNG .png More modern replacement for GIF. 
Allows transparency and full color 

ges. range. Good for any ima
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 Insert Data Field 

In addition to the text formatting functions outlined earlier, there is 
a “Data” function, which has been added to DiscStudio (see image).  

f the screen, when a These buttons are visible in the lower right o
text box is being edited or created: 

 

 

 

 

Selecting this option you will see the following window: 

 

 

These are helpful features to add data functions to your label. 
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Insert Data Field (continued) 

 

g window: 

Data Field List: 

Select this option to see the followin

 

 

 

This is used to store Data Fields that you have created.  In the 
example above, three have been created, and can easily be added, 
edited or deleted by the buttons on the right. 
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Text 

 

 wide range of text options. 

 to your Label 

To add text to your label click the Text tool button, then 
move the mouse pointer to the approximate position in 
which you want the text to appear, and click again. 

DiscStudio offers a

Adding Text

 

 

 

Note:  We recommend adding text as the last step in creating your 
label. Text with complex formatting involves considerable 
computing time and may slow down moving, adjusting or creating 
other objects. 
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A Sample Text Session 

sociated options and 
effects of the text tool is to use an example and create some fancy 

derstand the steps involved, you'll be 

tep 1 – Entering the Text 

lick the Text tool and move the cursor to approximately 
aced. 

 

The simplest way to explain the use and the as

text for a label.  Once you un
able to experiment and create virtually any effect you want. 

 

S

C
where you want the text to be pl

 

 

Now click again in the area to the right where the words “Text” are 
located and clear the letters out, now type the word “Bombastic” 
notice the real time preview as the letters change as you type into 
the text box. 

 

 

The text is small and not very impressive.  In the next few steps 
we'll adjust it to look much nicer. 
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A Sample Text Session (continued) 

 

e're going to use a more entertaining font:  House of Fun.  We 
will set the size to 48 points, and set the Style to Bold. 

Step 2 – Setting the Typeface and Size 

Click on the existing text in the drawing area.  Click the Font tab. 
The new window lets you select Font, Font Style and Size, as well 
as a couple of simple effects. 

W

 

 

 

ou can see the effect in the drawing area, as you make the 
anges. 

Y
ch
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A Sample Text Session (continued) 

 

Wordwrap 

As you are typing text in the text area on the right of the screen, 
the text box will automatically resize itself.   For an example, see 
the images below.  In the second box, the Enter key has been 

e area: 
pressed after the word “some,” in order to create multiple lines and 
to keep larger sized text form going outside the printabl

 

 

 

 

 

In addition, the justification of the text block may be changed to 
Left, Centered, or Right (see image): 
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A Sample Text Session (continued) 

 

 

The style of the text may also be changed (see image): 

 

 

 

This function allows the user to have unparalleled control over the 
tioning of the text.  This is a very powerful function and 

arrants taking the time to experiment with it in order to achieve 
optimum results. 

posi
w
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A Sample Text Session (continued) 

 

Effects 

ied to your 
xt.  See image below: 

 

By clicking the Effects tab additional effects can be appl
te
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A Sample Text Session (continued) 

 

Edge: 

The outer edge of the text can be changed from the Style pull-down 
menu (this is different from the Styles under the Format menu): 

 

 

 

The Size menu underneath the Style pull down menu is used to 
change the width of the effect when using the Glowing and Neon 
styles. 

The text may also be blurred via the Blur slider although this only 
applies to the Glowing and Neon styles. 

The transparency of the text effect can be adjusted by using the 
Transparency slider, or by setting a numeric value in the box.  This 
function also, only applies to the Glowing and Neon styles. 
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A Sample Text Session (continued) 

 

Shadow effects can also be applied to your text (see following 

de 
artially transparent: 

 

image).  To utilize Shadow effects, place a check in the Enable 
box.  The X and Y positions of the shadow may be adjusted.  In 
addition, the shadow of the text may also be blurred and / or ma
p

 

 

Summary 

There are many available text manipulations, and thousands of 
combinations.  Make use of the real time text preview, and have 
fun experimenting. 
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DiscStudio Questions and Answers (FAQ)  

ort a particular TIFF file for use as a 
ackground? 

A. TIFF allows programmers to select from a wide array of optional 
features depending on their requirements.  This means that some 
TIFF files may not be usable for some applications.  If possible, use 
another graphics program to convert the TIFF to another format 
which can be imported into DiscStudio. 

 

Q. When I try to copy a graphics image from another application 
using the Windows Clipboard it doesn’t have an option to paste. 

A. Windows Copy and Paste is not supported in DiscStudio from 
external applications.  The correct way to load an external image is 
by the Clipart button or as a background image (see page 108). 

 

Q. DiscStudio doesn't seem to work on my Windows 98 computer. 

A. DiscStudio is designed for Windows 2000 or later versions of 
indows only.  While it may work on some Windows 98 computers, 

 not supported. 

 

In this section you will find answers to some questions that may 
arise during the operation of DiscStudio: 

 

Q. Why can't I imp
b

W
such use is
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DiscStudio Questions and Answers (FAQ) (continued) 

. Make sure you have the latest updates for your version of 
indows.  Some errors of this type have been traced to the use of 

pported version of Windows. 

ge, at the top menu bar) to 
ove the larger object behind the smaller one. Then you can select 

the smaller object.  When you are done, move the smaller one 

 

. Make the selection rectangle larger.  Some shapes (particularly 
osed curves) may be larger than their drawn size 

A. For most tools right click outside the main circular drawing area, 
or click on the selection (cursor) tool. 

 

Q. My text object slows down DiscStudio and interferes with 
manipulating other objects. 

A. That's normal.  Text objects require a lot of processor time.  We 
recommend doing text as the last step of creating your label. 

 

 

Q. DiscStudio occasionally crashes or exhibits odd behavior (objects 
can't be selected "ghost" images appear, etc.). 

A
W
an outdated version of the "gdiplus.dll" file.  Also, make sure you 
are using a su

 

Q. I can see an object but I can't select it because it's "behind" a 
larger, transparent object. 

A. Use the Move Back tool (under Arran
m

behind the larger one again. 

Q. I am trying to select a curved object by dragging a selection 
rectangle around it, but it won't select. 

A
curves and cl
indicates. 

 

Q. How can I unselect a tool if I change my mind and no longer 
want to use it? 
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DiscStudio Questions and Answers (FAQ) (continued) 

 

Q. How can I delete a background image? I added the image when 
I started my drawing and now I don't want it, but UNDO would 

. Why can't I see the fonts that are included with DiscStudio in 

scStudio are not installed in the 

nstall fonts you don't use frequently.  
his can slow down both booting and operation of Windows, as well 

art images to DiscStudio? 

s.  See page 79 for more information and page 41 for 
lder locations. 

 own background or clipart images to DiscStudio? 

 also accept other bitmap 
age types.  See page 76 for more details. 

 with 
our printer. 

 

cause me to lose all the changes since then. 

A. Delete a background image by setting the background color to 
white. 

 

Q
Control Panel, Fonts? 

A. The fonts included with Di
Windows Fonts folder.  You can use the Control Panel, Fonts, Add 
Font utility to install any of them if you wish.  Then they will be 
available to all applications. 

Note: It is not a good idea to i
T
as consuming Windows resources. 

Q. Can I add my own background or clip

A. Yes. Normally, backgrounds are jpeg images and clipart uses 
transparent GIF or PNG.  DiscStudio will also accept other bitmap 
image type
default fo

 

Q. Can I add my

A. Yes. Normally, backgrounds are jpeg images and clipart uses 
transparent GIF or PNG.  DiscStudio will
im

Q. I have an inkjet printer that has a tray for printing DVDs or CDs.  
Will it work with DiscStudio? 

A. Although it is not guaranteed that DiscStudio will work with 
printers other than those from XLNT Idea, Disc Studio includes 
many popular templates so chances are good that it will work
y
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Sample Session: Printing a CD/DVD 

Printer Properties Setup 

As installed, the printer driver is set for optimal printing for most 
Ink-jet Printable discs.  The following shows you how to change the 

nge these settings run DiscStudio.  This will open the 
ndow shown below: 

settings to suit your taste and your particular media. 

To cha
wi
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Sample Session: Printing a CD/DVD (continued) 

 

owing window: Click File > Printer Setup to open the foll

 

 

 

If you have more than one printer installed on your computer make 
sure “Xi440 CD/DVD Printer” is selected in the pull down Name 
window. 
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Sample Session: Printing a CD/DVD (continued) 

To change specific quality settings from their defaults, click the 
es window Properties button. This will open the Document Properti

shown below: 

 

 

r Source will always be set to “Automatically Select”. 

The Media option should be set to “Coated”, as this has been 
determined to be the best setting for all around use with the 
majority of ink-jet printable discs. 

For faster prints you can try selecting “Normal”. In the Quality 
Setting although you trade off print quality for faster speed. 

For the highest print quality output, set Media to “Glossy” and 
Quality settings to “Best”. 

 

Since the Xi440 will always automatically load a disc for a print job 
your Pape
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Sample Session: Printing a CD/DVD (continued) 

 

The Quality setting simply determines the DPI (dots per inch) being 
printed.  Best setting is 4800/2400 DPI, Normal setting is 600 DPI, 
nd Draft setting is 300 DPI.  1200 DPI can be used by selecting 

Custom, and editing the Advanced options. 

To open the Advanced options click on the Advanced button in the 
lower right of the Document Properties window, to see the following 
window: 

 

a

 

 

Please click on the down arrow, to the right of Color Intent, and 
choose “Graphics.”  Then, click OK.  And, click OK again to return to 
DiscStudio. 
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Sample Session: Printing a CD/DVD (continued) 

 

Click on the DiscStudio button in the lower right of the screen.  This 
will open the DiscStudio program showing the following window: 
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Sample Session: Printing a CD/DVD (continued) 

 

As stated earlier, the options for creating a label in DiscStudio 
allow for an almost infinite variety of design options.  For this 

al, the simplest way to create a label will be shown.  From the 
bove window click the Background Image button on the right hand 

side of this window.  This will open the selection window as shown 
below: 

 

tutori
a
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Sample Session: Printing a CD/DVD (continued) 

Again, for this tutorial you will just be shown the basics of the 
DiscStudio software.  Select the 3dclocks.jpg image, and then 
click the Open button.  This will bring you back to the main 
DiscStudio window with the 3dclocks.jpg image centered in the 
window as shown: 
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Sample Session: Printing a CD/DVD (continued) 

 

Now click the File > Save As, to open a standard Windows save 
dialog: 

 

 

 

DiscStudio saves its created labels as .dst files, so select where
you want this label to be saved, type a name for it, then click Save.  
In this example we have saved it to the My Documents folder and 
named it sample.dst.  
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Sample Session: Printing a CD/DVD (continued) 

 

Not click File > Print, to open the following print window with 
preview.   

 

 

 

ou may notice some differences from the standard Windows print 

To print click the OK button, this will eject the print tray. Place an 
k-jet printable disc in the tray and press the center Change CD 

button. This will draw the disc into the Xi440 and begin printing. 
When the Xi440 has finished printing and fully ejected the tray you 
may remove and examine your disc. 

Congratulations!  You have now printed your first disc using your 
new Xi440. 

Y
dialog box. The Preview window and Gamma and Saturation 
controls are added to allow fine tuning to the final printed output 
which can very between the different manufacturers of ink-jet 
printable CD/DVDs.  

in
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Uninstalling DiscStudio 

 

If you have installed DiscStudio as a stand-alone program, and 
later want to install the DiscWorks package, we recommend 
ninstalling DiscStudio first to avoid having two copies in different 
cations.  

From the Start Menu choose Settings/Control Panel/Add or Remove 
Programs.  Locate the DiscStudio entry and left click on it.  Now 
click the Change/Remove button.  Uninstallation is automatic. 

If you have added graphic images to the Backgrounds or Clipart 
folders, or you have saved disk labels, the uninstaller will not 
remove them automatically.  For a complete uninstallation, remove 
these entries and folders manually by deleting the folder: 

C:\Program Files\XLNTidea\DiscStudio (and all its subdirectories). 

 

If you are uninstalling DiscStudio prior to installing DiscWorks, you 
should copy any images you have added to the new folders (under 
Program Files/DiscWorks) before deleting the originals. 

u
lo
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DIN Connector Interface 

he 6-pin minicircular auxiliary interface located conveniently on T
the rear of the Xi440 is used for connecting the Xi440 with auxiliary 
equipment such as an automated CD transporter or auto-loader.  

Pin assignments are as illustrated below 
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DiscStudio Questions and Answers (FAQ) 

In this section you will find answers to some questions that may 

background?

A TIFF allows p onal 
features depending on their requirements. This means that 
some TIFF files may not be usable for some applications. If 
possible, use another graphics program to convert the TIFF to 
another format which can be imported into DiscStudio. 

Q When I try to copy a graphics image from another application 
using the Windows Clipboard it has a rectangle that can't be 
deleted surrounding it. 

A Windows Copy and Paste are not supported in DiscStudio. While 
the procedure above may work, the correct way is to create a 
rectangle and import the graphics image as a picture or clipart, 
or to use the quick Clipart button on the main interface (see 
page 76). The outline of your rectangle can be set to "clear" to 
make it disappear. 

Q DiscStudio doesn't seem to work on my Windows 98 computer. 

A DiscStudio is designed for Windows 2000 or later versions of 
Windows only. While it may work on some Windows 98 
computers, such use is not supported. 

Q DiscStudio occasionally crashes or exhibits odd behavior 
(objects can't be selected, "ghost" images appear, etc.). 

A Make sure you have the latest updates for your version of 
Windows. Some errors of this type have been traced to the use 
of an outdated version of the "gdiplus.dll" file. Make sure you're 
using a supported version of Windows. 

Q I can see an object but I can't select it because it's "behind" a 
larger, transparent object. 

A Use the Move Back arrow to move the larger object behind the 
smaller one. Then you can select the smaller object. When 
you're done, move the smaller one behind the larger one again. 

arise during the operation of DiscStudio. 

Q Why can't I import a particular TIFF file for use as a 
 

rogrammers to select from a wide array of opti
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Q I  but 
when I try to resize it, it snaps back to the center of the label. 

ng the Ellipse 

e 
object. You can then move the object (and the clipart) 

 

Q Can I set new defaults for objects? 

t 
 both 

e Text properties 
window. 

er 

 

t 

always select and manipulate objects by moving the interfering 
object back (use the Move Selected Object to Back button). 
Move it to the proper level again once you're done. 

made a circle and moved it to the right place on my label,

A Circles are designed to be centered. If you want to be able to 
freely move and resize circles, create them usi
tool. 

Q I imported a clipart image, but it's stuck at the middle of the 
label and can't be moved. 

A Instead of importing the image to the label itself, create a 
rectangle (or other suitable shape) and import the image using 
the clipart feature found in the Fill/color properties for th

anywhere you want. Alternately, use the quick clipart button 
(see page 78) 

Q I am trying to select a curved object by dragging a selection 
rectangle around it, but it won't select. 

A Make the selection rectangle larger. Some shapes (particularly 
curves and closed curves) may not select unless the selection
rectangle is significantly larger than the object appears to be. 

A You can set the default line and fill colors using the pull down 
menus at the left of the main window. You can set default tex
properties by checking the Default for new object box in
the Font Selector and Format tabs of th

Q How can I unselect a tool if I change my mind and no long
want to use it? 

A For most tools just right click outside the main drawing area. 
(You may have to move the mouse slightly before the pointer 
reverts to being an arrow). 

Q My text object slows down DiscStudio and interferes with 
manipulating other objects.

A That's normal. Text objects require a lot of processor time, and 
the container boxes may be large. We recommend doing tex
as the last step of creating your label. Remember that you can 
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Q How can I delete a background or clipart image? I added the 
image when I started my drawing and now I don't want it, but 
UNDO would cause me to lose all the changes since then. 

A Delete a background or clipart image for either an object or th
entire

e 
 label by setting the background color to white. 

any 

Note: It is not a good idea to install fonts you don't use 

Q Why can't I see the fonts that are included with DiscStudio in 
Control Panel, Fonts? 

A The fonts included with DiscStudio are not installed in the 
Windows Fonts folder, but are only available to DiscStudio. You 
can use the Control Panel, Fonts, Add Font utility to install 
of them if you wish. Then they will be available to all 
applications. 

frequently. This can slow down both booting and operation of 
Windows, as well as consuming Windows resources. 

Q Can I add my own background or clipart images to DiscStudio? 

A Yes. Normally, backgrounds are jpeg images and clipart uses 
transparent GIF. DiscStudio will also accept other bitmap image 

tion and page 41 for 

ee that DiscStudio will work with printers 
other than those we supply, chances are good that it will work with 

 

types. See page 79 for more informa
default folder locations. 

Q I have an inkjet printer that has a tray for printing DVDs or 
CDs. Will it work with DiscStudio? 

Although we don't guarant

your printer. Note that DiscStudio is not intended for use with 
stick-on DVD or CD labels as it does not have positioning controls
intended for this purpose. 
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Supplies 
 

Ink Cartridges 

Your Xi440 CD/DVD Publisher uses standard Lexmark ink cartridge
which are widely available:

s 
 

Black – full ink:  Lexmark 16 

Blac

 

 

ry to 
ow on ink. 

 

Color – full ink:  Lexmark 26 

Color – half/full ink: Lexmark 27 

k – half/full ink: Lexmark 17 

Note: The full ink cartridges are more economical if you normally
print many discs over a short period of time. 

 

Ink cartridges can be replaced separately.  It is only necessa
replace the cartridge that is l
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Supplies (continued) 

Ds and DVDs 

CDs and DVDs are now widely available at 
y stores.  Your Xi440 CD/DVD Publisher 

mal or "full face5") 

res an adaptor available 
 

D/DVD r 57 mm sizes – requires an 
m. 

ntable: 
me CDs or DVDs have a glossy white surface that looks printable 

 

                                                          

C

Ink-jet printable 
computer and office suppl
can use: 

 

Standard CD/DVD (nor

Mini CD/DVD (normal or "full face") – requi
at www.xlntidea.com.

Business Card C  in 63, 61 o
adaptor available at www.xlntidea.co

 

Most ink-jet printable CDs or DVDs will have a matte white finish, 
some have a matte silver finish.  Either type will work with your 
Xi440.  Just make sure any media you buy are ink-jet pri
so
but is not (they are designed for stick-on labels). 

 
5 "Full face" CDs or DVDs are printable on their inner diameter up to the 

center hole; normal ones have a clear plastic area around the center hole. 
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Cleaning the Print Head 

 

s required if your prints show horizontal 

is happens when one or more nozzles in the print head 
ocked. This may occur if the printer has been left unused 

r several weeks or months, and is always required when new ink 

tton and wait for the 
cleaning procedure to finish. 

Print head cleaning i
"banding" in either the black or any of the colored inks. Bands are 
horizontal lines that show white or are fainter than the surrounding 
areas. Th
become bl
fo
cartridges are installed. 

1. From the Printer Driver Control Panel (see page 22) click on 
the Cartridge Maintenance tab. 

2. Make sure an expendable printable CD is in the printer tray. 

3. Click the "Clean print nozzles" bu

If cleaning the print heads does not eliminate the banding, replace 
the cartridge. 
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Xi 440 Questions and Answers (FAQ) 
 

The following questions and answers should help you solve 
problems you may encounter with your Xi440. 

Q My Xi440 won't print. 

A Check to make sure your Xi440 has power: the Power button 
should light green when pressed. If it doesn't, check the outlet 
where the power adapter is plugged in and make sure the 
pow

Check the USB cabl th a new one. Try 
plug
the 

If th time you try to use it, the 

Q There are horizontal lines in the printed output. 

A This indicates a partially blocked printhead. Try cleaning the 
printheads (see page 107). If this doesn't solve the problem, 
replace the color or black cartridge as appropriate. The ink 
cartridges for the Xi440 have built-in printheads. 

Q The printed image on the CD isn't centered. 

A Centering (print alignment) is adjusted from the DiscStudio 
software. See page 22 for the detailed procedure. The software 
remembers the setting between sessions so you should only 
have to do this once unless you change printers. 

Q Can I use any CDs in the Xi440? 

A You must use ink-jet printable CDs or DVDs in the printer. The 
surface on ordinary CDs won't absorb the ink properly. 
Printable CDs and DVDs are available from most office supply 
stores and from many suppliers on the internet. 

Q Can I refill the ink cartridges to save money? 

A It's theoretically possible to do so, but since the printheads are 
built into the cartridges refilling a cartridge doesn't renew the 
head. This can result in poor quality (blurred print or poor 
colors) and horizontal lines in your printout. 

er adapter is plugged into the back of the printer. 

e by replacing it wi
ging it into another USB port. (You may have to reinstall 
printer driver if you do this.) 

e printer won't work the first 
driver may not have been correctly installed. Try uninstalling 
and reinstalling the driver (see page 17.) 
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Q I put in new cartridges and the black (or color) doesn't se
print. 

em to 

 Are you sure you removed the tape that protects the printhead? 
On some 3rd party cartridges this tape is not obvious and is 

ed.) 
he end of the tape 

rent blue color) and carefully remove it. 

ould 
n dried 

. 

l. 
d 

 If it doesn't work, 

A

difficult to see. (Lexmark cartridges have it clearly mark
Use a magnifying glass if necessary to find t
(it's normally a transpa

Try pressing a paper towel against the printhead (which is the 
small projection at the bottom of the cartridge). A small 
amount of black or three colors (cyan, magenta, yellow) sh
be deposited on the paper. If not, the cartridge has bee
out or is empty. Follow the cleaning procedure on page 22

It is sometimes possible to restore a dried out printhead by 
applying a mild solvent like distilled water or hydrogen 
peroxide6 to the printhead using a pad made of a paper towe
Let it soak for a couple of minutes then install the cartridge an
run a printhead cleaning cycle (page 107).
replace the cartridge

                                                           
6 Some users recommend denatured alcohol but that has the potential to

damage the print head jets and is not recommended b
 

y XLNTIdea. 
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